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ADO.NET
An Introduction to ADO.NET

Agenda & ReadingAgenda & Reading
 Agenda:

 Relational Databases
 ADO .NET Architecture
 Overview of ADO.NET
 Getting Started with ADO.NET
 Using the Data Source Windowg
 Overview of Data Providers
 Understanding Connections

 Creating Connections 
 Application Configuration File Application Configuration File
 Universal Data Link File

 Recommended Reading:
 Microsoft ADO.NET 2.0 step by step, Rebecca M. Riordan

Ch  1  G i  S d i h ADO NET Chapter 1: Getting Started with ADO.NET
 Chapter 2: Using Connections

 ADO.NET 
 http://msdn2.microsoft.com/en-us/library/e80y5yhx(VS.80).aspx

 Namespace covered: 
 System.Data, System.Data.OleDb

 Hands-on Lab: 
 Lecture19Lab: Creating Connections 
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 Lecture19Lab: Creating Connections 

Databases
InputForm

OutputDatabases
 Projects can display and update the data from database files

 VB.NET uses ADO.NET for database access

Output

Column

 Database
 Tables

 Records
 Fi ld

Row

 Fields
 Primary Key

 It is used to uniquely identify each record in a table.
 Foreign Key

 It is a field in a relational table that matches the primary key column of another table.p y y
 Establishes a relationship between tables.

 Constraints
 Relationships

Primary key in 
Table Customers

Primary key in 
Table Orders

p
 Examples

 Administration
 Library

Foreign key in 
Table Orders One to many 

relationship
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ADO NET ArchitectureADO .NET Architecture
Client/Presentation tierClient/Presentation tier

Windows formsWindows forms

ADO .NET is designed to work well with 
desktop and Internet applications

DataSetDataSetDataSetDataSet
DataTableDataTableDataTableDataTable

D t C lD t C l

Business tierBusiness tier

Data tierData tier
Data Access object (class)Data Access object (class) Data adapter/Data adapter/

Table adapterTable adapter
DataColumnDataColumn
DataConstraintDataConstraint
DataRowDataRow

DataSetDataSetDataSetDataSet
DataTableDataTableDataTableDataTable

DataColumnDataColumn
D t C t i tD t C t i t

Data SourceData Source
DataRelationCollectionDataRelationCollectionDataRelationCollectionDataRelationCollection DataConstraintDataConstraint

DataRowDataRow

DataRelationCollectionDataRelationCollectionDataRelationCollectionDataRelationCollectionWeb formsWeb forms

XMLXML

DataSetDataSetDataSetDataSet
DataTableDataTableDataTableDataTable

DataColumnDataColumn
DataConstraintDataConstraint
DataRowDataRow

DataRelationCollectionDataRelationCollectionDataRelationCollectionDataRelationCollection

In n-tier applications, data is usually passed from the database to a middle-tier 
business object and then to the user interface. To accommodate the exchange 
of data, ADO.NET uses an XML-based persistence-and-transmission format. 
That is, to transmit data from one tier to another, an ADO.NET solution 
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DataRelationCollectionDataRelationCollectionDataRelationCollectionDataRelationCollection , ,
expresses the in-memory data (the DataSet) as XML and then sends the XML to 
the other component.



Overview of ADO NET
Data SourceData Source

Overview of ADO.NET
DataSetDataSetDataSetDataSet

DataTableDataTableDataTableDataTable
DataColumnDataColumn

.Net Data Provider.Net Data Provider

pterpterDataAdapterDataAdapter//TableAdapterTableAdapter
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onnDataColumnDataColumn

DataConstraintDataConstraint
DataRowDataRow

DataRelationCollectionDataRelationCollectionDataRelationCollectionDataRelationCollection

pterpterDataAdapterDataAdapter//TableAdapterTableAdapter
SelectCommandSelectCommand
UpdateCommandUpdateCommand
InsertCommandInsertCommand
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DeleteCommandDeleteCommand

DataReaderDataReaderDataReaderDataReader

ADO.NET is not a revision of Microsoft ActiveX Data Objects (ADO) but a new way to manipulate data that is based on disconnected
data and Extensible Markup Language (XML). 
In a traditional client/server application, components usually open connections to data sources, and the connections remain open as 
long as the application is running Open connections to data sources not only consume resources and increase network traffic but alsolong as the application is running. Open connections to data sources not only consume resources and increase network traffic but also 
reduce application performance and scalability.
ADO.NET has been designed to work with disconnected DataSets to help overcome the problems listed earlier. Applications are 
connected to the data source only long enough to fetch and update data. 
ADO NET uses XML as the universal transmission format This guarantees platform interoperability as long as the receiving component
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ADO.NET uses XML as the universal transmission format. This guarantees platform interoperability as long as the receiving component 
runs on a platform on which an XML parser is available. Any software component can share ADO.NET data as long as it uses the same 
XML schema as the format for the transmitted data.

Getting Started with ADO NET
Example: NorthwindDemo

Getting Started with ADO.NET
 The process of connecting data to the controls on a form is called data binding. Data binding 

can be performed in code, but it can also be performed at design time.
 The Data Sources Window Offers Drag-and-Drop Data-Binding

 Configuring a Data Source Using the Data Source Window
 Add a Data Source to a Project 

Ch  D | Add N  D  S  d Choose Data | Add New Data Source menu command
 Choose the data connection
 Save the Connection String to the Application Configuration File
 Choose the Database objects (table)j ( )
 (Demo: 19.1_01AddDataSource.wmv)

 Preview the Contents of a table
 Double-click the NorthwindDataSet.xsd file in the Solution Explorer
 Right click the Customer table  choose Preview Data from the context menu Right-click the Customer table, choose Preview Data from the context menu
 (Demo: 19.1_02PreviewData.wmv)

The Data Sources Window is the main window for viewing the data available to your project. You can drag objects from the Data
Sources window onto forms to create data-bound controls that display and navigate data.
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p y g
The Data Source Configuration Wizard simplifies connecting your application to data in databases. You can run this wizard to add or 
edit a data source in your project.  

Data Source WindowData Source Window
 Creating a Data-Bound Control Using the Data Source Window

 Add a Data-Bound Control to a Form Add a Data Bound Control to a Form
 Open the Data Source Window
 Drag the Customer table from the Data Source window to the form

 A DataGridView control and a BindingNavigator control are added onto the form
 (Demo: 19.1_03AddDataGridViewControl.wmv)

Step 1: 19.1_01AddDataSource.wmv
Step 2: 19.1_02PreviewData.wmv
Step 3: 19.1_03AddDataGridViewControl.wmv
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Overview of Data ProvidersOverview of Data Providers
 A .NET Framework data provider is used for connecting to a database, executing commands, and 

retrieving results. Manage access to data stores.
Th  NET F k d  id  h   i l d d i  h  NET F k  The .NET Framework data providers that are included in the .NET Framework are:
 OLE DB .NET Data Provider

 Access to OLEDB data store
 SQL Server NET Data Provider .Net Data Provider.Net Data Provider CC CC

DatabaseDatabase

 SQL Server .NET Data Provider
 Access to Microsoft SQL Server database

 ODBC .NET Data Provider
 Access to native ODBC drivers 

DataAdapterDataAdapter
SelectCommandSelectCommand
UpdateCommandUpdateCommand
InsertCommandInsertCommand
DeleteCommand
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 Oracle .Net Data Provider
 Access to Oracle database

 The Core Objects of .NET Framework Data Providers
 C ti

DataReaderDataReader

 Connection
 Establishes a connection to a specific data source. 

 Command
 Executes a command at a data source. Exposes Parameters and can enlist a Transaction from a Connection.   p

 DataReader
 Reads a forward-only, read-only stream of data from a data source. 

 DataAdapter
P l   D S d l  d  i h h  d  
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 Populates a DataSet and resolves updates with the data source



Understanding ConnectionsUnderstanding Connections
 Connections

 Represent the physical connection to a data source
T Types
 OleDbConnection
 SqlConnection
 OdbcConnection

O l C OracleConnection
 Properties

 ConnectionString: Gets or sets the string that is used to open the connection. It contains Provider, Data Source, 
username and password information.

 State: Gets a strin  that describes the state f the c nnecti n State: Gets a string that describes the state of the connection.
 Methods:

 Open: Opens a database connection with the settings specified by the ConnectionString. 
 Close: Closes the connection to the database. This is the preferred method of closing any open connection. 
E Event
 StateChange: Occurs when the state of the connection changes

 Creating connections
 Method 1: Using the Toolbox
 Method 2: Creating at Run Time

The Connection object is used to establish a connection to a database. The Connection object has properties, such as DataSource,
UserID and Password that are needed to access a particular DataSource Once a connection to the data source has been
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UserID, and Password that are needed to access a particular DataSource. Once a connection to the data source has been 
established, Commands can be run against the data source, and result sets that are returned in the form of streams can be read by 
DataReaders or stored in DataSet objects.

Method 1: Using the Toolbox
Example: ConnDemo

Method 1: Using the Toolbox
 Add a Connection to the Toolbox

 Open the Toolbox, and right-click the Data tab Open the Toolbox, and right click the Data tab
 Select Choose Items from the Context menu.
 Select the OleDbConnection check box
 (Demo: 19.2 01CreateConnection.wmv )( _ )

 Add a Connection to a Form
 Drag the OleDbConnection control onto the form
 Set the Connection String property of the control Set the Connection String property of the control

 Open the Server Explorer, and click the Add DataConnection button
 In the Data Link Properties dialog box, click the Provider tab. 

 Click Microsoft.ACE.OLEDB.12.0 Provider, and then click Next.
 Click the Connection tab, and then click the ellipses button (...) to select the database file
 Click OK.
 (Demo: 19.2_02SetConnection.wmv)

 O  th  C ti Open the Connection

try {
cnMyConnection.Open();                
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MessageBox.Show(cnMyConnection.ConnectionString + " " + cnMyConnection.State);
}  ...

Method 2: Creating at Run TimeMethod 2: Creating at Run Time
 Using Constructors

 New(), or
 N (C ti St i ) New(ConnectionString)

 Creating connection at run time
 Declare a connection object

private OleDbConnection cnMyConnection;
 Create the connection object with the ConnectionString

try {
string DBconnString = @"Provider= Microsoft.ACE.OLEDB.12.0;Data 

private OleDbConnection cnMyConnection;

Source=H:\compsci280\Northwind.mdb;";
cnMyConnection = new OleDbConnection(DBconnString);
cnMyConnection.Open();
MessageBox.Show(cnMyConnection.ConnectionString + " " + cnMyConnection.State);

} catch (Exception Ex) {

Print the connection status

} ( p ) {
MessageBox.Show(Ex.ToString(), "ERROR", MessageBoxButtons.OK, MessageBoxIcon.Error);

} finally {
if (cnMyConnection != null) 

cnMyConnection.Close();
}}
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CAUTION: It is recommended that you always close the Connection when you are finished using it in order for the connection to be
returned to the pool. 

Application Configuration FileApplication Configuration File
 Understanding Application Configuration File

 A configuration file is generated in the same folder as the application's executable file and 
h  h  f ll    C D fhas the following naming convention: ConnDemo.exe.config

T    i  i  h  A li i  C fi i  Fil   d i  i

application's main 
namespace
 To store a connection in the Application Configuration File at design time

 Select on the Project menu, click Properties.
 Select the Settings pane.
 Enter a name (ConnectionSetting) in the Name column The name cannot contain spaces Enter a name (ConnectionSetting) in the Name column. The name cannot contain spaces.
 Select (connectionStrng) from the Type drop-down list.
 Select Application from the Scope drop-down list. 
 Enter a ConnectionString or click the ... button to select the database file.g
 (Demo: 19.3AppConfig.wmv )
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Using an App config fileUsing an App.config file
<?xml version="1.0" encoding="utf-8" ?><configuration>
... Store settings as 

name(key)/value pairs
application's main 

namespace<connectionStrings>
<add name="ConnDemo.Properties.Settings.ConnectionSetting" 

connectionString="Provider= Microsoft.ACE.OLEDB.12.0;Data Source=H:\compsci280\Northwind.mdb;"          
providerName="" />
</connectionStrings>

name(key)/value pairsnamespace

 To get the ConnectionString from the Application Configuration File in 

g

g g pp g
code
 The Properties.Settings object provides access to the application's settings and 

allows you to dynamically store and retrieve property settings and other allows you to dynamically store and retrieve property settings and other 
information for your application.

txtConfig.Text = Properties.Settings.Default.ConnectionSetting;

When Visual Studio creates a new project it automatically generates a Properties folder and populates it with classes that wrap the 
configuration settings you generate with the Properties Editor. The Properties Editor updates the xxx.config file and the Settings.cs 
class file (the class wrapper around the generated properties) automatically.
The ConnectionString properties we set in the previous examples are hard-coded. That’s not a problem for little example. But in the 

Handout19COMPSCI28013

real world, the location of a database is almost certain to change. We should store the database connection string in a single place 
for ease of application maintenance.

OLE DB Universal Data Link ( udl)OLE DB Universal Data Link (.udl)
 UDL files

 Store the connection string that an ADO .NET OLEDbConnection object uses to establish a database g j
connection

 Creating a UDL file
 Create a text file in a folder, rename it as conn.udl 
 D bl li k it t   th  ADO ti  t i  dit Double-click it to open the ADO connection string editor
 Click the Provider tab

 Choose Microsoft.ACE.OLEDB.12.0 Provider 
 Click the Connection tab Click the Connection tab

 Click the … button to select the database file
 Enter username and password if needed
 Click Test Connection button to test the connection

 Cli k OK Click OK

The selections you make are written as a 
connection string in the .udl file. 

Select the 
database file
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Using a UDL FileUsing a UDL File
 Creating a connection using a UDL file

 Use FileName in the ConnectionString Use FileName in the ConnectionString
 Sets the name of the Universal Data Link (UDL) file for connecting to the data source. 

try {
sing (OpenFileDialog dlgOpenFile ne OpenFileDialog()) {using (OpenFileDialog dlgOpenFile = new OpenFileDialog()) {
dlgOpenFile.Filter = "UDL files(*.UDL)|*.udl";
if (dlgOpenFile.ShowDialog() == DialogResult.OK) {

Use “File Name” to 
read from a udl file

string DBconnString = "File Name=" + dlgOpenFile.FileName;
cnMyConnection = new OleDbConnection(DBconnString);
cnMyConnection.Open();
MessageBox.Show(cnMyConnection.ConnectionString + " " + cnMyConnection.State);

}}
}

} catch ...

Because UDL files can be modified externally to any ADO.NET client program, connection strings that contain references to UDL files 
will be parsed every time the connection is opened. 
It is possible to supply connection information for an OleDbConnection in a Universal Data Link (UDL) file; however you should avoid 
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p pp y ( ) ; y
doing so. UDL files are not encrypted and expose connection string information in clear text. Because a UDL file is an external file-
based resource to your application, it cannot be secured using the .NET Framework. 

Summary
DataSetDataSetDataSetDataSet

DataTableDataTableDataTableDataTable
DataColumnDataColumn

.Net Data Provider.Net Data Provider
DataAdapterDataAdapter
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 ADO.NET
 Architecture

DataConstraintDataConstraint

DataRowDataRow

DataRelationCollectionDataRelationCollectionDataRelationCollectionDataRelationCollection

SelectCommand

UpdateCommand

InsertCommand

DeleteCommand
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 Creating a Simple Data-Bound form
 Using the Data Source Window

 Using Data Providers
DataReaderDataReader

 Using Data Providers
 Using Connections

 Creating connections using the Toolbox
 Creating connections at run time

Data SourceData Source

g
 Application Configuration files
 UDL files
 Path

..."Data Source=" + Application.StartUpPath + "\\db1.mdb;"

The ConnectionString can be set at design-time; however, only the absolute path can be used. This poses a problem when you move 
the system to a different directory, a disk etc. We can set the ConnectionString using a relative path at run-time.

f f
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Application.StartUpPath: the path for the executable file that started the application, not including the executable name.


